USER'S GUIDE FOR THE NAVY

COMPUTER ASSISTED MEDICAL DIAGNOSIS (NCAMD) SYSTEM

VERSION 2.0

H. L. Ly
L. L. Merrill
D. M. Pearsall

Technical Report 93-22

Approved for public release; distribution unlimited.

NAVAL HEALTH RESEARCH CENTER
P. O. BOX 85122
SAN DIEGO, CALIFORNIA 92186-5122

NAVAL MEDICAL RESEARCH AND DEVELOPMENT COMMAND
BETHESDA, MARYLAND

Prepared by:
Hoa L. Ly
L.L. Merrill
D.M. Pearsall

Naval Health Research Center
Medical Information Systems and Operations Research Department
P.O. Box 85122
San Diego, CA 92186-5122

Report No. TR-93-22 was supported by the Naval Medical Research and Development Command, Bethesda, MD, Department of the Navy, under Work Unit No. 63706N M0095.005-6103. The views expressed in this article are those of the authors and do not reflect the official policy or position of the Department of the Navy, Department of Defense, nor the U.S. Government.
Summary

The Navy Computer-Assisted Medical Diagnosis (NCAMD) system is designed to assist Independent Duty Corpsmen (IDCs) in rendering a medical diagnosis. The NCAMD system was written using Microsoft FoxPro, Version 2.0, database management system. For each encounter the signs, symptoms, and laboratory information collected can be gathered on data entry forms created for NCAMD or entered directly (real time) into the system. A Chronological Record of Medical Care (SF600) can be generated automatically to document the encounter.

The NCAMD system User’s Guide was written to familiarize the IDCs with the NCAMD software. The keyboard and mouse commands necessary to run the various options are explained in conjunction with the associated screens.
# Table of Contents

## Section 1 Introduction

1. Purpose of the Navy Computer-Assisted Medical Diagnosis (NCAMD) System User’s Guide ........................................ 1
1.2 Navy Computer-Assisted Medical Diagnosis (NCAMD) .... 1
1.3 References ...................................................................... 1
1.4 Terms and Abbreviations ............................................. 2

## Section 2 System Summary

2.1 System Application ...................................................... 3
2.2 Programming Language ................................................ 3
2.3 Security/Privacy .......................................................... 3
2.4 Flexibility ...................................................................... 3
2.5 Maintenance ................................................................... 3
2.6 "Too Many Files Open" Error Message ............................. 3
2.7 "Out of Environment Space" Message ............................... 3
2.8 System Organization .................................................... 4
2.9 Menu Options .............................................................. 4

## Section 3 Accessing the System

3.1 Entering NCAMD (Log-On) ........................................... 5
3.2 Exiting the NCAMD (Log-Off) ....................................... 6
3.3 Mouse Techniques ....................................................... 7
3.4 Choosing Menu Options ............................................... 7
3.5 Dialogs ......................................................................... 8

3.5.1 Scrolling a List .......................................................... 8
3.5.2 Choosing an Option on a Popup ................................... 8
3.5.3 Choosing a Check Box, Radio Button, or Push Button ... 9
3.5.4 Text Editing Box ....................................................... 9
3.5.5 Zoom Arrows .......................................................... 9

## Section 4 System Transactions

4.1 System Menu ............................................................. 10
4.1.1 Help <F1> ............................................................... 10
4.1.2 Change Password ................................................... 11
4.1.3 Backup ................................................................... 12
4.1.4 Restore ................................................................. 12
4.1.5 Calculator .............................................................. 13
4.1.6 Calendar/Diary ....................................................... 13

4.2 File Menu ................................................................. 14
Section 5 Appendices

A. Text Editor Commands ................................................. A1
B. Encounter Forms ......................................................... B1
C. Installation Guide ......................................................... C1
Section 1 Introduction

1.1 Purpose of the Navy Computer-Assisted Medical Diagnosis (NCAMD) System User’s Guide. The purpose of the user’s guide is to provide Independent Duty Corpsmen (IDCs) with the information necessary to effectively use NCAMD. In this user’s guide, the basic structure and features of the NCAMD system will be explained.

1.2 Navy Computer-Assisted Medical Diagnosis (NCAMD). Medical care on board many small ships and submarines is the responsibility of IDCs. These vessels often operate in remote areas where IDCs cannot easily obtain consultations. Therefore, the Navy Medical Research and Development Command (NMRDC) initiated a program to develop a set of diagnostic algorithms that could be automated. The objectives of this effort are to:

- Provide medical practitioners with accurate medical diagnostic and treatment information
- Prevent unnecessary, hazardous, and disruptive medical evacuations by providing diagnostic assistance to IDCs
- Improve communications between isolated IDCs and their supporting medical officers by providing a standardized method for information collection
- Gather clinical information in a modifiable diagnostic knowledge base to ensure diagnostic accuracy

1.3 References. The following references are provided as technical and background information.

1.4 Terms and Abbreviations.

- **Carriage Return <CR>**. Notation used to denote a carriage return typically executed by pressing the <ENTER> or <RETURN> key on a computer keyboard. If a mouse is available on the computer system, "click" or press the top left button for a return.

- **Database Management (DBM)**. A management approach to database design consisting of what information is collected, where it is stored, and how it is processed by computer software.

- **Default**. A response assumed by NCAMD. If the default value is correct, the user need only press the <ENTER> or <RETURN> key.

- **Expert System**. A computer program that emulates the behavior of a human expert in a specific area of knowledge.

- **FoxPro**. A database management development system written by the Fox Software, Inc. FoxPro, Version 2.0, was used to develop the NCAMD system.

- **NCAMD**. Navy Computer-Assisted Medical Diagnosis.

- **SAMS**. SNAPS Automated Medical System, Version 7.0, is a FoxPro software application for handling shipboard medical department forms, files and data.

- **SNAPS**. Shipboard Non-tactical ADP Program.

- **System**. The combination of hardware, firmware, and software designed to function as an integrated unit.

- **SF600**. The Chronological Record of Medical Care standardized form used for documenting a medical encounter.
Section 2 System Summary

2.1 System Application. IDCs provide medical services on many U.S. Navy submarines and small surface ships. To assist the corpsmen and enhance their diagnostic skills, the U.S. Navy has initiated the development of the NCAMD system.

2.2 Programming Language. The NCAMD software was written in the FoxPro, Version 2.0, programming language. FoxPro is a DBM system created for the personal computer to produce computer applications.

2.3 Security/Privacy. The security module will maintain user passwords allowing log-on access to NCAMD and its database files. Menu options are assigned to the user through a security key system in FoxPro. NCAMD collects and stores data covered under the 1974 Privacy Act.

2.4 Flexibility. Since NCAMD was created by using the FoxPro utilities, enhancements and updates to the system can be accomplished with minimal programming. NCAMD was design to compatible with SAMS.

2.5 Maintenance. The primary maintenance functions consist of security options, file and format definitions, user file updates, knowledge base editing, and initialization of data.

2.6 "Too Many Files Open" Error Message. If the "Too many files open" message occurs, the following window will open. Select <Cancel> to end the program and return to the root directory (cd c:). Modify the CONFIG.SYS by adding or editing the FILES command to a minimum of 50 files (FILES = 50).

```
Too Many Files Open

<Cancel> <Ignore>
```

Figure 1. Error Message

2.7 "Out of Environment Space" Message. If an "Out of Environment Space" Message occurs, change the CONFIG.SYS file. Return to the root directory (cd c:) and modify the CONFIG.SYS by adding the SHELL command. The "/P" will make it permanent and the "/E:(size)" will expand the environment space from the default of 160 bytes. Reboot the system after changing the CONFIG.SYS.

```
SHELL=COMMAND.COM /P /E:512 (DOS Version 3.2 and above)
SHELL=COMMAND.COM /P /E:32  (DOS Version 3.1 and below)
```
2.8 **System Organization.** The system has 5 main menus which are (1) System, (2) File, (3) Edit, (4) Diagnosis, and (5) Window. Accessing the system requires a password (see Section 3). Once the password is successfully entered, the top menu, shown in Figure 2, will appear.

![Figure 2. Main Menu]

2.9 **Menu Options.** All NCAMD system options are shown in Figure 3. The system is operated using either a mouse or the keyboard to select these options.

![Figure 3. Menu Options]
Section 3  Accessing the System

3.1  Entering NCAMD (Log-On). Change the current directory to NCAMD or the one in which NCAMD was installed on the system (c:\CAMD). At the MS-DOS prompt, type CAMD and the following security prompt will be displayed.

Unauthorized access to this United States Government Computer System and/or software is prohibited by Title 18, United States Code, Section 1030. This system may only be used for unclassified official business.

Figure 4. Log-On Screen

Type in the password and <CR>. After an acceptable password has been entered a brief greeting will be shown.

Computer-Assisted Medical Diagnosis

If you have any problems or questions, please contact:
  Ms. Hoa L. Ly
  Naval Health Research Center
  P.O. Box 85122
  San Diego, CA 92186-85122
  DSN 553-8401 or Com (619) 553-8401
  E-mail: ly@nhrc.navy.mil

Press any key to continue...

Figure 5. Greeting Screen
Navy Computer-Assisted Medical Diagnosis (NCAMD)

The Navy Computer-Assisted Medical Diagnosis (NCAMD) system contains disease descriptions, diagnostic assistance, and treatment recommendations. Only the most common diseases in each category are considered for medical diagnosis. The nonspecific disease in each area represents nonsurgical, nonlife-threatening cases, which in general do not require evacuation.

YOUR JUDGMENT MUST TAKE PRECEDENCE. The NCAMD system cannot make the subjective evaluations that are often so important in medical diagnosis.

The <F1> key will give additional help ...

Press any key to continue ...

Figure 6. Greeting Screen Continued

3.2 Exiting the NCAMD (Log-Off). Choose <Quit> from File options to exit NCAMD.

<table>
<thead>
<tr>
<th>System</th>
<th>File</th>
<th>Edit</th>
<th>Diagnosis</th>
<th>Window</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Reindex</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Quit</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

If any windows are left open the following window will appear:

Windows are still opened. Do you want to close them?

<YES>  <NO>

Figure 7. File Options
3.3 Mouse Techniques

- **Point.** Position the pointer (arrow) at the specific location on the screen. The pointer moves in the same direction as the mouse.

- **Click.** Point to an object, then press and release the mouse button once.

- **Double Click.** Point to an object, then press and release the mouse button twice in rapid succession.

- **Drag.** Hold the mouse button down, roll the mouse until the pointer is in the desired location, and release the mouse button.

3.4 Choosing Menu Options

- **Keyboard.** Use the <Alt> key in conjunction with the highlighted letter of the menu pad. To access the File menu option, for example, press <Alt> <F>, then press <CR>.

- **Mouse.** Point to the menu pad and press the left mouse button to display the menu popup window. Point to the desired option and press the left mouse button.

![Menu Pad Diagram]

Figure 8. Menu Popup Window
3.5 Dialogs. Dialogs are special boxes for data entry that allow the user to choose the action about to take place.

![Diagram of Dialog Box]

Figure 9. Example of Dialog Boxes

3.5.1 Scrolling a List

- **Keyboard.** Use the arrow keys <↑> or <↓> to select an option, then press <CR>.
- **Mouse.** Click on the up or down arrow on the scroll bar. Then holding down the mouse button on either arrow will cause the scrolling to continue until released.

3.5.2 Choosing an Option on a Popup

- **Keyboard.** Press the <Tab> key to the popup control. Then press <CR> to open the window. Choose an using the arrow keys, and press <CR>.
- **Mouse.** Point to the popup control and press the mouse button to display the popup. Drag to the desired option, then release the mouse button.
3.5.3 Choosing a Check Box, Radio Button, or Push Button

- **Keyboard.** Press the `<Tab>` key to move the cursor to a check box, radio button, or push button, then press `<CR>`.

- **Mouse.** Point to a check box, radio button, or push button, then press the left mouse button.

3.5.4 Text Editing Box. The text editor allows the user to type and modify information displayed in a region of the screen (e.g., Treatment or SF600 Report). When text editing, use the cursor to move through the text. The cursor looks like a flashing underscore, when in the insert mode, and a flashing box when in the overwrite mode. Press the `<Insert>` key to switch between modes. It is easy to move the cursor through text using 8 basic keys. Four of these keys can also be used in combination with a modifier key `<Ctrl>` to move the cursor a greater distance. See Appendix A for the table of Text Editor Commands.

3.5.5 Zoom Arrows

- **Keyboard.** To increase (↑) or reduce (↓) the box size `<Tab>` to the appropriate arrow, and press `<CR>`.

- **Mouse.** Point to the desired arrow and click.
Section 4 System Transactions

4.1 System Menu. To access the top level menu options using the mouse, point to the option and click. To use the keyboard press down the alternate function key and the first letter of the option (e.g., enter <Alt><S> to access the System menu. The System menu options are used for file maintenance and desk accessories.

<table>
<thead>
<tr>
<th>System</th>
<th>File</th>
<th>Edit</th>
<th>Diagnosis</th>
<th>Window</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help...F1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change Password</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Backup</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Restore</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Calculator</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Calendar/Diary</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 10. System Menu Options

4.1.1 Help <F1>. On-line assistance can be obtained by pressing the <F1> key at any time. NCAMD provides context-sensitive help that can be accessed by pressing <F1> or selecting the <Help> option on the System menu.

Figure 11. Help Topics Window
For more details on a particular topic, select the `<Topics>` button and press `<CR>`. To see information about the following topic in the system, choose `<Next>`. To see information about the previous topic, choose `<Previous>`. The `<Look Up>` and `<See Also>` functions are not used by the NCAMD system. To close the `<HELP>` window using the keyboard press the escape `<ESC>` key. To close it using the mouse, point to the small white rectangle in the top left corner of the window and click.

![Figure 12. Help Detail Window](image)

4.1.2 **Change Password.** This option lets the user to change the password. When **Change Password** option is chosen from the System menu, type a new password and press `<CR>`. Remember this change is permanent, so memorize the new password or make a notation and place it somewhere safe.

![Figure 13. Change Password](image)
4.1.3 Backup. The Backup option is used to copy the database to another file. Select the drive and directory where the file is to be stored, enter a name for the backup file, and select the <<Backup>> button. The system will automatically begin this process and display a message when finished. In Figure 14, the backup file was named CAMD9503.BCK. The 9503 represents the year and month in which the files were saved.

![Backup Screen](image)

Figure 14. Backup Screen

4.1.4 Restore. This option allows the user to restore or reinstall the database previously backed up by the NCAMD system. To restore a backup file, enter the disk drive and directory where the backup file was stored, enter the name of the file, and select the <<Restore>> button. The system will automatically begin this process and display a message when finished.

![Restore Screen](image)

Figure 15. Restore Screen
4.1.5 Calculator. When the user chooses the Calculator option from the System menu, a graphic of a calculator appears on the screen. This calculator used like a standard pocket calculator and can be used by keyboard or the mouse. To use the mouse, simply click on the appropriate numbers and symbols on the calculator. With the keyboard, type the equation as it would be written. Most calculator keys have the same keyboard equivalents.

<table>
<thead>
<tr>
<th>Keyboard</th>
<th>Calculator</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>MC</td>
</tr>
<tr>
<td>R</td>
<td>MR</td>
</tr>
<tr>
<td>N</td>
<td>*</td>
</tr>
<tr>
<td>A</td>
<td>+</td>
</tr>
<tr>
<td>Z</td>
<td>6</td>
</tr>
<tr>
<td>S</td>
<td>7</td>
</tr>
</tbody>
</table>

Figure 16. Calculator

4.1.6 Calendar/Diary. When the user chooses the Calendar/Diary option from the System menu, a monthly calendar appears with the current day selected. This calendar is used just like any other calendar to check dates and keep track of appointments. Once it has been used, the default then becomes the last day selected. To close this menu option, press <ESC>.

![Calendar/Diary](image)

Figure 17. Calendar/Diary
To the right of the Calendar panel is the Diary panel. Use the Diary panel to input text associated with any date on the calendar panel. To activate the Diary panel, press <Tab> or choose Diary from Diary menu. To activate the Calendar panel, press <shift><Tab> or choose Calendar from the Diary menu.

4.2 File Menu. The File menu contains options for manipulating data files. Currently there are only two options on this menu: Reindex and Quit.

![Figure 18. File Menu](image)

- **Reindex.** This option is used to reindex or sort the database files. When the user chooses the Reindex option from File menu, a brief message will be displayed. The window will disappear when the task is completed.

- **Quit.** The Quit option ends current NCAMD session. When chosen, a message will be shown on the screen, and will return to the MS-DOS prompt (c:\CAMD).

4.3 Edit Menu. The Edit menu options are used from within the Diagnosis menu, when editing the treatment section of an encounter or a SF600 form.

![Figure 19. Edit Menu](image)

- **Undo.** Reverses the last action that was performed while text editing. Selecting the Undo option repeatedly will reverse all entries made during the current editing session.

- **Redo.** This is the opposite of Undo. Choose Redo to restore the text to its previous condition. Selecting this option will reverse the Undo option.
• **Cut.** Removes selected text from any field, record, or text editing field.

• **Copy.** Duplicates the selected text and places it on the clipboard.

• **Paste.** Inserts a copy of the clipboard contents into the current file, field, or text editing window at the cursor location. It will replace the contents of the clipboard with the selected text.

• **Clear.** Permanently removes selected text without placing it on the clipboard. If the user chooses this option when text is selected, the result is the same as pressing the `<Del>` or backspace keys. Additionally, the **Clear** option is used to erase a window or the desk top.

• **Select All.** All lines of text in the current editing window are selected.

• **Goto Line.** Displays the `<Goto>>` dialog box shown below. When this option is chosen, the cursor moves to the beginning of the specified line, and the text line is displayed in the window. If the line number specified is greater than the number of lines in the window, the cursor is positioned on the last line.

![Goto Line Dialog](image)

**Figure 20. Goto Line Dialog**

### 4.4 Diagnosis Top Menu Option.

Currently, NCAMD has 3 diagnostic modules: Abdominal Pain, Chest Pain, and Ocular Pain. Each area has its own medical diagnosis, disease, and treatment databases. The diagnosis data is grouped by disease categories, in which only the most common diseases are considered. The Diagnosis menu is the main menu for NCAMD, see Appendix B. for examples of encounter forms for the Chest Pain and Abdominal Pain Modules.

```
<table>
<thead>
<tr>
<th>System</th>
<th>File</th>
<th>Edit</th>
<th>Diagnosis</th>
<th>Window</th>
</tr>
</thead>
<tbody>
<tr>
<td>Register</td>
<td>Patient</td>
<td>Encounter</td>
<td>Disease/Treatment Lookup</td>
<td>SF600 Report</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Training Mode</td>
</tr>
</tbody>
</table>
```

**Figure 21. Diagnosis Menu**
4.4.1 Register Patient. When the Register Patient option is selected a patient selection window opens (see Figure 23). The patient database can be searched using complete or partial names or social security numbers. A question mark "?" can be used as a wild card character. After the information is entered, select the <Browse> button to search for a patient. When using the keyboard press <Tab> until the cursor is located on top of the button, then press <CR>.

<table>
<thead>
<tr>
<th>System</th>
<th>File</th>
<th>Edit</th>
<th>Diagnosis</th>
<th>Window</th>
</tr>
</thead>
<tbody>
<tr>
<td>Register Patient</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Encounter</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disease/Treatment Lookup</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SF600 Report</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Training Mode</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 22. Register Patient

PATIENT SELECTION

Social Security:

- - 2222

Last Name:

First Name:

« OK » < BROWSE > < CANCEL >

Figure 23. Patient Selection Window

When the candidate list is displayed, the user has the option to <Select>, <Edit>, <New>, <SAMS>, or <Cancel>. Selection allows the user to choose a patient and continue entering the encounter. The <Edit> option is used when the user wants to change information that is contained in the file, such as last name. If the patient is not found in the candidate list, <New> allows the user the enter the patient into the lookup file. Another option with NCAMD is the interface to the SAMS. If the patient is registered in SAMS, the <SAMS> option will copy this information into the NCAMD system. The <Cancel> function is used to abort the process.

Select from the following candidates:

000-00-2222   DOE, JOHN
222-22-2222   FLINTSTONE, FRED

<Select> <Edit> <New> <Sams> <Cancel>

Figure 24. Candidate List
The Patient Enter/Edit window is called from the previous window in Figure 24. It is displayed when the user selects <New>, <Edit>, <SAMS>, or when the patient cannot be found. After the data are entered the user either selects <OK> to save the record or <CANCEL> to abort the process.

**Patient Enter/Edit**

Social Security: 000 - 00 - 2222

Last Name: DOE

First Name: JOHN

Middle Initial: A

Date of Birth: 07/13/65

Sex: M

Rate/Rank: HM1

<OK> <CANCEL>

Figure 25. Patient Enter/Edit Window

4.4.2 Encounter. After the Encounter option is selected from the Diagnosis menu, the patient Seek Function will be executed. If there is a pending encounter on the current patient, the system will prompt to <Resume> the current encounter, create a <New> encounter for the same complaint, or to <Cancel> this session.

<table>
<thead>
<tr>
<th>System</th>
<th>File</th>
<th>Edit</th>
<th>Diagnosis</th>
<th>Window</th>
</tr>
</thead>
<tbody>
<tr>
<td>Register Patient</td>
<td>Encounter</td>
<td>Disease/Treatment Lookup</td>
<td>SF600 Report</td>
<td>Training Mode</td>
</tr>
</tbody>
</table>

Figure 26. Encounter Option
If the <New> screen is chosen, the screen shown in Figure 28 will appear.

Figure 28. Patient Encounter Screen
For a new encounter, the first button to be selected is `<Complaint>`. When the complaint button is activated the following window will appear:

![Complaint Window](image)

**Figure 29. Complaint Window**

Once the complaint has been entered, the symptom information can be added. Notice that the first information in the symptom window is age. If this were a pending encounter, some of the symptom information already may have been entered. Select the `<Symptom>` button to continue entering information.

![Symptom Window](image)

**Figure 30. Symptom Window**
When the <Symptom> button is selected the question window will open. After answering the question, either select <OK> to accept the answer or <Cancel>. Cancel will stop the question-and-answer session.

![Figure 31. Question Window](image)

Use the <Diagnosis> button to open the Disease window after all of the questions have been answered. Notice that the Disease window has 3 options that allow the user to <Select> the marked diagnosis; <View> a description of the marked diagnosis, or <Cancel>.

![Figure 32. Disease File](image)
Once the diagnosis is entered, select the <Assist> button for the computer to compute a diagnosis.

![Figure 33. Assist Window](image)

While NCAMD is analyzing the information entered, the following sign will appear on the screen.

![Figure 34. Calculating Message](image)
When the calculations are completed, the predicted diagnosis will appear in the <Assist> window (Figure 35) and the <Explanation> button will be enabled.

![System File Edit Diagnosis Window]

**Figure 35. Calculated Diagnosis**

The <Explanation> button can be selected after the diagnosis is computed. The <HOW> function lists the differences between signs and symptoms of the selected diagnosis and the NCAMD predicted diagnosis. Select <OK> to close the window.

![System File Edit Diagnosis Window]

**Figure 36. Explanation Window**
The <VIEW> function can be used for two purposes: to display the disease description or to capturing treatment information for the treatment field.

**Disease Description**

Appendicitis (APPEND). Acute appendicitis

Acute appendicitis results from a bacterial invasion of the appendix with inflammation. Incidence is highest in adolescents and young adults, peaking between ages 15 and 24. Typically the pain initially is poorly localized in the periumbilical region.

1. **TREATMENT PROTOCOL AT A GLANCE.** (see detailed discussion of treatment below; this section is for quick reference). Definitive treatment of acute appendicitis is surgical. Notify command of need for immediate MEDEVAC. The treatment goals are pending MEDEVAC.

A. Place patient at strict bed rest with head of bed slightly elevated. Monitor vital signs, fluid intake and output, and progress of symptoms and examination.

<<OK>>

**Figure 37. View Treatment Explanation**

The next step is to enter treatment information. This can be either typed directly into the treatment window, or taken from the disease file.

System File Edit Diagnosis Window

**Patient Encounter**

Date 09/28/95 Time 10:02 Status P Provider 1

Sex M Age 30

SSN 000-00-2222

**<Complaint>** Acute Abdominal Pain **<Diagnosis>** APPENDICITIS

**<Symptom>**

AGE => 30

**<Assist>**

APPENDICITIS

NONSPECIFIC ABDOMINAL PAIN

**<Explanation>**

Enter treatment in here.

**<Print>** **<<Save>>** **<Cancel>**

**Figure 38. Treatment Information**
Figure 39 shows data being captured while using the <Edit> function and the <Explanation> <View> function.

<table>
<thead>
<tr>
<th>System</th>
<th>File</th>
<th>Edit</th>
<th>Diagnosis</th>
<th>Window</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Undo</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Redo</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Cut</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Copy</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Paste</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Disease Description

1. **TREATMENT PROTOCOL AT A GLANCE.** Definitive treatment of acute appendicitis is surgical. Notify command of need for immediate MEDEVAC. The treatment goals are pending MEDEVAC.

A. Place patient at strict bed rest with head of bed slightly elevated. Monitor vital signs, fluid intake and output, and progress of symptoms and examination.

<< OK >>

Figure 39. Edit Treatment Information

The information captured can then be pasted and edited in the patient encounter by using functions from Edit menu.

System File Edit Diagnosis Window

Patient Encounter

Date 09/28/95 Time 10:02 Status P Provider 1
Patient Name DOE First JOHN
SSN 000-00-2222 Sex M Age 30

<Complaint> Acute Abdominal Pain <Diagnosis> APPENDICITIS

<Symptom> <Assist>APPENDICITIS NONSPECIFIC ABDOMINAL PAIN

AGE => 30

<Treatment>
Notified the command of the need for immediate MEDEVAC. The treatment goals are pending MEDEVAC. Placed patient at strict bed rest with head of bed slightly elevated. Monitoring vital signs, fluid intake and output, and progress of symptoms and examination.

<Print> <<Save>> <Cancel>

Figure 40. Treatment Information
The encounter is completed and can be saved and/or printed. Use <Cancel> to exit.

![Figure 41. Save Encounter](image)

When the <Print> option is selected, a print dialog box (Figure 42) will appear. The information may be copied to a file or sent directly to the printer. To save an encounter to a file, select the File (•) option in the print encounter box, then enter the name of the report, and select the <OK> button. To send an encounter to the printer, select Printer (•) option in print encounter box, then <OK>.

![Figure 42. Print Encounter](image)
4.4.3 Disease/Treatment Lookup. This option allows the user to review the disease description and treatment protocol. The Disease/Treatment Lookup file contains 7 sections: Disease Description, Discussion, Differential Diagnosis, Treatment of Disease, Usual Course with Treatment, Complications, and Management of Complications. When this option is selected from the Diagnosis Menu the following popup list of descriptions or treatment information will appear. To end this process select <Quit> or to view any particular disease or treatment description simply selected the disease on the scrolling window, then select the <View> button.

DISEASE/TREATMENT REFERENCES

ACUTE PANCREATITIS
ANGINA
APPENDICITIS
CHEST INFECTION
CHOLECYSTITIS
INGUINAL HERNIA
NONSPECIFIC ABDOMINAL PAIN

<Select>  <View>  <Quit>

Figure 43. Disease Table Reference

4.4.4 SF600 Report. This option extracts the encounter data and compiles it into the SF600 report format. The report can either be sent to a printer or stored in a file. The <Edit> option allows this report to be modified.

<table>
<thead>
<tr>
<th>System</th>
<th>File</th>
<th>Edit</th>
<th>Diagnosis</th>
<th>Window</th>
</tr>
</thead>
<tbody>
<tr>
<td>Register Patient</td>
<td>Encounter</td>
<td>Disease/Treatment Lookup</td>
<td>SF600 Report</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Training Mode</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 44. SF600 Report

The SF600 Report option allows the user to fill in social security number, last name, first name and/or encounter date. If any field is unknown leave it blank. The input process allows partial information to be entered. Use a question mark "?" for a single unknown character. To
look up the existing patient encounter in the system, at least one field must be entered. Select <OK> when finished, <Browse> to see the entire patient encounter listing, or <Cancel> to quit.

```
Convert Encounter to SF600 Report

Social Security:  - -
Lastname:  DOE
Firstname:  
Encounter Date:  / / 

< OK >  <BROWSE>  <CANCEL>
```

Figure 45. Create SF600 Report

A candidate list will then appear for the user to either <Select> a patient from the list or to <Cancel> the process.

```
Patients in File

[0000002222] Doe, John

< Select >  <Cancel>
```

Figure 46. Patient Candidate List

After the correct patient is selected, the system will search the encounter for a specified date. Select <OK> to continue or <Cancel> to quit.

```
Patient: 000002222
Date:  9/29/95

000002222  14:44:38  Acute Abdominal Pain

< OK >  <CANCEL>
```

Figure 47. Patient Data Screen
The **Report Editing** screen appears after the report is generated. Read it carefully and make necessary changes. Press **<Save>** to save the change, **<Print>** to output the report, **<Cancel>** to quit out the option. The output device can be either a file or printer. If choosing a **<File>**, remember to enter the filename at the filename field. Select **<OK>** when sending the report to a device, or **<Cancel>** to abort the process. See Appendix A for editing commands.

![Report Editing](image)

**Report Editing**

This 30 Years old male presents with pain over his whole chest, which radiates to the left arm. The pain began about 2 days to a week ago and was gradual in onset. The patient has been in continuous pain. He describes the pain as sharp. Numbness is absent. The pain is moderate in severity and seems to be getting worse since it began. By history, coughing makes the pain worse, and pentaphenabarbitol and gin seems to make the pain better. The patient reports dyspnea associated only with this illness. The patient has no cough. Sputum is absent. Orthopnea is absent. Paroxysmal nocturnal dyspnea is absent.

**< Print >  < Save >  < Cancel >**

Figure 48. Report Editing Screen

### 4.4.5 Training Mode

When this option is selected, information is stored in a temporary file and not in the permanent database.
Section 5 Appendices

A. Text Editor Commands ............................................. A1
B. Encounter Forms ..................................................... B1
C. Installation Guide ................................................... C1


### Cursor Movements

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Right Arrow</td>
<td>Move one character to the right</td>
</tr>
<tr>
<td>Left Arrow</td>
<td>Move one character to the left</td>
</tr>
<tr>
<td>Up Arrow</td>
<td>Move up on line</td>
</tr>
<tr>
<td>Down Arrow</td>
<td>Move down one line</td>
</tr>
<tr>
<td>Home</td>
<td>Move to the end of the line</td>
</tr>
<tr>
<td>End</td>
<td>Move up one window-full of text</td>
</tr>
<tr>
<td>PgUp</td>
<td>Move down one window-full of text</td>
</tr>
<tr>
<td>Ctrl + Right Arrow</td>
<td>Move one word right</td>
</tr>
<tr>
<td>Ctrl + Left Arrow</td>
<td>Move one word left</td>
</tr>
<tr>
<td>Ctrl + Home</td>
<td>Move to the beginning of text</td>
</tr>
<tr>
<td>Ctrl + End</td>
<td>Move to the end of text</td>
</tr>
</tbody>
</table>

### Select Text with Keyboard

<table>
<thead>
<tr>
<th>Key Sequence</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift Arrow Keys</td>
<td>Select a range of characters</td>
</tr>
<tr>
<td>Shift Arrow Keys</td>
<td>Select a range of words</td>
</tr>
<tr>
<td>Shift + Ctrl + Arrow</td>
<td>Select from cursor to beginning of text</td>
</tr>
<tr>
<td>Shift + Ctrl + End</td>
<td>Select from cursor to end of text</td>
</tr>
<tr>
<td>Ctrl + A</td>
<td>Select entire document</td>
</tr>
</tbody>
</table>

### Select Text with Mouse

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drag</td>
<td>Select a range of characters</td>
</tr>
<tr>
<td>Double-click</td>
<td>Select a range of words</td>
</tr>
<tr>
<td>Double-click and drag Keys</td>
<td>Select from cursor to beginning of text</td>
</tr>
<tr>
<td>Triple-click</td>
<td>Select from cursor to end of text</td>
</tr>
<tr>
<td>Triple-click and drag</td>
<td>Select entire document</td>
</tr>
</tbody>
</table>
## Delete and Replace

<table>
<thead>
<tr>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Place cursor to the right of the character, press Backspace, or place cursor at the character, press Delete</td>
<td>Delete a character</td>
</tr>
<tr>
<td>Place cursor anywhere in word, press Ctrl+Backspace</td>
<td>Delete a word</td>
</tr>
<tr>
<td>Select and press Backspace</td>
<td>Delete a selection</td>
</tr>
<tr>
<td>Select text to be replaced, type new text (or Paste)</td>
<td>Replace existing text</td>
</tr>
</tbody>
</table>

## Cut, Copy and Paste

<table>
<thead>
<tr>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the text, press Ctrl+X or use <strong>Cut</strong> in the <strong>Edit</strong> menu</td>
<td>Cut Text</td>
</tr>
<tr>
<td>Select the text, press Ctrl+C or use <strong>Copy</strong> in the <strong>Edit</strong> menu</td>
<td>Copy Text</td>
</tr>
<tr>
<td>Press Ctrl+V or use <strong>Paste</strong> in the <strong>Edit</strong> menu</td>
<td>Delete a selection</td>
</tr>
<tr>
<td>Select text, press Ctrl+V or use <strong>Paste</strong> in the <strong>Edit</strong> menu</td>
<td>Replace existing text</td>
</tr>
</tbody>
</table>
# Abdominal Pain Data Sheet

**SITE OF PAIN AT ONSET**
- RUQ
- LUQ
- RLQ
- LLQ
- Upper Half
- Lower Half
- Right Half
- Left Half
- Central
- General
- Right Flank
- Left Flank
- No Pain

**SITE OF PAIN AT PRESENT**
- RUQ
- LUQ
- RLQ
- LLQ
- Upper Half
- Lower Half
- Right Half
- Left Half
- Central
- General
- Right Flank
- Left Flank
- No Pain

**OTHER SYMPTOMS:**
- **NAUSEA:**
  - Yes
  - No
- **APPETITE:**
  - Decreased
  - Normal
- **VOMITING:**
  - Yes
  - No
- **JAUNDICE:**
  - (Hx or yellow skin/sclera)
  - Yes
  - No
- **BOWELS:**
  - Normal
  - Constipated
  - Diarrhea
  - Blood in Stool
  - Mucus in Stool
- **URINATION:**
  - Normal
  - Frequency
  - Painful
  - Darker Urine
  - Blood in Urine

**TYPE OF PAIN:**
- (free of pain at times = intermittent, constant = steady, constant but varying in intensity = colicky)
- Intermittent
- Steady
- Colicky

**SEVERITY OF PAIN:**
- (If in obvious distress = severe, everything else = moderate)
- Moderate
- Severe

**DURATION OF PAIN:**
- (How long has the pt had the pain?)
- Hours

**AGGRAVATING FACTORS:**
- (have patient move, cough)
  - Movement
  - Cough
  - Food
  - Breathing
  - Other
  - None

**RELIEVING FACTORS:**
- Lying Still
- Vomiting
- Antacids
- Food
- Other
- None

**PROGRESS OF PAIN:**
- (at time of examination)
- Better
- Same
- Worse

**PAST HISTORY**

**PREVIOUS INDIGESTION:**
- Yes
- No

**PREVIOUS SIMILAR PAIN:**
- Yes
- No

**PREVIOUS SURGERY:**
- (Intraperitoneal abdominal surgery or trauma)
- Yes
- No

**PREVIOUS ILLNESS:**
- (any illness requiring hospitalization)
- Yes
- No

**TAKING MEDICATIONS:**
- Yes
- No

**OB/GYN HISTORY**

**PERIODS:**
- Not Started
- Ceased
- Regular
- Irregular

**PREGNANCY:**
- Impossible
- Possible
- Confirmed

**LAST PERIOD:**
- Normal
- Late/Overdue

**FAINT/DIZZY:**
- Yes
- No

**VAGINAL DISCHARGE:**
- Yes
- No

**PREV GYN HX:**
- Yes
- No
## PHYSICAL EXAM

### VITAL SIGNS
- **Temperature:** __________
- **Blood Pressure**
  - **Systolic:** __________
  - **Diastolic:** __________
- **Pulse Rate:** __________
- **Respiration:** __________

### SITE OF TENDERNESS
(area of significant pain, palpate most painful last)
- RUQ
- LUQ
- RLQ
- LLQ
- Upper Half
- Lower Half
- Right Half
- Left Half
- Central
- General
- Right Flank
- Left Flank
- No Pain

### GENERAL/LAB
- **MOOD:**
  - Normal
  - Anxious
  - Distressed
- **COLOR:**
  - Normal
  - Pale
  - Flushed
  - Cyanotic
  - Jaundiced

### WBC COUNT:
__________

### ABDOMINAL EXAM
#### INSPECTION:
- **Normal**
- **Visible Peristalsis**
- **Decreased Abd. Movement**

#### ABNORMAL SCARS:
- **Yes**
- **No**

#### GUARDING:
- **Yes**
- **No**

#### BOWEL SOUNDS:
- **Normal**
- **Absent**
- **Hyperactive**

#### DISTENSION:
- **Normal**
- **Absence of distension**
- **Increased distension**

#### MASSES:
- **Yes**
- **No**

#### REBOUND TENDERNESS:
- **Yes**
- **No**

#### RECTAL EXAM
- **Normal**
- **Mass Felt**
- **General Tenderness**
- **RIGIDITY**:
  - **Yes**
  - **No**

### CORPSMAN'S DIAGNOSIS:
- Appendicitis
- Nonspecific Abd. Pain
- Renal Colic
- Perf. Duod. Ulcer
- Cholecystitis
- Small Bowel Obs.
- Other:

### MEDICAL OFFICER'S DIAGNOSIS:
- Appendicitis
- Nonspecific Abd. Pain
- Renal Colic
- Perf. Duod. Ulcer
- Cholecystitis
- Small Bowel Obs.
- Other:

### MEDEVAC:
- **Yes**
- **No**
# CHEST PAIN DATA SHEET

<table>
<thead>
<tr>
<th>SSN:</th>
<th>DATE/TIME:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>AGE:</td>
</tr>
<tr>
<td></td>
<td>SEX:</td>
</tr>
</tbody>
</table>

## Site of Pain
- Central
- Chest
- L. Side
- R. Side
- Epigastric
- Other

## Pain Radiation
- Yes
- None
- L Arm
- R Arm
- Both Arms
- Back
- Shoulders
- Neck
- Jaw
- Throat
- Fingers/Hands
- Epigastric
- Other

## Duration of Pain
(How long has the pt had the pain?)
- _______ Hours

## Type of Pain
- Tight
- Gripping
- Dull
- Sharp
- Burning
- Stabbing
- Hvy/Press/Crush
- Aching
- Nagging

## Severity of Pain
(Do not ask if obvious distress = severe
everything else = moderate)
- Moderate
- Severe

## Aggravating Factors
- Movement
- Cough
- Breathing
- Sitting
- Lying Down/Rest
- Leaning Forward
- Other
- None

## Onset of Pain
- Sudden
- Gradual

## Numbness
- Yes
- No

## Time Course of Pain
(at times free of pain = intermittent,
everything else = continuous)
- Continuous
- Intermittent

## Progress of Pain
- Better
- Same
- Worse

## Relieving Factors
- Nitro
- Rest
- Walking
- Morphine
- Other Drugs
- Other
- None

## Other Symptoms:

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Dyspnea:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Absent</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>This Illness</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Chronic</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Orthopnea:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Inability to</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>breath except</td>
<td></td>
<td></td>
</tr>
<tr>
<td>when upright</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Cough:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Absent</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>This Illness</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Chronic</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PND:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Post-nocturnal</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>dyspnea</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sputum:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>No</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Nausea:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>No</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Appetite:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Recent change</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Normal</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Decreased</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Vomiting:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>No</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Bowels:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Normal</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Constipated</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Diarrhea</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

## Past History:

<table>
<thead>
<tr>
<th>Previous Chest Pain</th>
<th>Smoker</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Previous C-R Illness</th>
<th>Positive Hx</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>MI</td>
</tr>
<tr>
<td>No</td>
<td>Angina</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>History Major Surgery</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>Bronchitis</td>
</tr>
<tr>
<td>No</td>
<td>Hypertension</td>
</tr>
<tr>
<td>Diabetes</td>
<td>None</td>
</tr>
</tbody>
</table>
### PHYSICAL EXAM

<table>
<thead>
<tr>
<th>VITAL SIGNS</th>
<th>BLOOD PRESSURE</th>
<th>EXAMINATION</th>
<th>RESPIRATORY MOVEMENT:</th>
</tr>
</thead>
<tbody>
<tr>
<td>TEMPERATURE</td>
<td>SYSTOLIC:</td>
<td>EDEMA:</td>
<td>(abnormal = dif. between full inspire &amp; full expire. gt 2 inches, or expansion of sides unequal, otherwise = normal):</td>
</tr>
<tr>
<td>PULSE RATE</td>
<td>DIASTOLIC:</td>
<td>Absent</td>
<td>Normal Abnormal</td>
</tr>
<tr>
<td>RESPIRATION</td>
<td></td>
<td>Ankles</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Other</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>LAB RESULTS</th>
<th>GENERAL EXAM</th>
<th>SHIVERING: (not due to environ. or exercise):</th>
</tr>
</thead>
<tbody>
<tr>
<td>EEG RESULTS:</td>
<td>MOOD: (obvious distress or physical symptoms = distress, concern about illness = anxious):</td>
<td>Normal Rhonchi</td>
</tr>
<tr>
<td>ST Elevation</td>
<td>Normal</td>
<td>Yes</td>
</tr>
<tr>
<td>T Depression</td>
<td>Anxious</td>
<td>No</td>
</tr>
<tr>
<td>Q Waves</td>
<td>Distressed</td>
<td></td>
</tr>
<tr>
<td>ST Depression</td>
<td>In Shock</td>
<td></td>
</tr>
<tr>
<td>Arrhythmia</td>
<td></td>
<td></td>
</tr>
<tr>
<td>No Apparent Distress</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SGOT:</td>
<td>COLOR: (consider temp., check palms &amp; conjunctiva on black or oriental):</td>
<td>Normal Raised Lowered</td>
</tr>
<tr>
<td></td>
<td>Normal</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Pale</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>Flushed</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Cyanotic</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>COLD/CLAMMY:</th>
<th>JUGULAR VENOUS PRESS.: (pt. reclined at 45 deg., chin at 30 deg., to left miniscus more than 1/2 dist to clavical = raised, otherwise = normal):</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>Normal</td>
</tr>
<tr>
<td>No</td>
<td>Raised Lowered</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>TENDERNESS CALVES:</th>
<th>HEART SOUNDS: (if 1st &amp; 2nd sounds= lub-dub then normal, other = abnormal):</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>Normal</td>
</tr>
<tr>
<td>No</td>
<td>Abnormal</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>TENDERNESS CHEST:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>Normal</td>
</tr>
<tr>
<td>No</td>
<td>Abnormal</td>
</tr>
</tbody>
</table>

**CORPMAN's DIAGNOSIS:** MI ANGINA Non-Specific Chest Pain CHEST INFECTION OTHER: 

**Medical Officer's DIAGNOSIS:** MI ANGINA Non-Specific Chest Pain CHEST INFECTION OTHER: 

**MEDEVAC:** Yes No
This Appendix contains the listings of the four files used in the installation of the CAMD system: CAMDREAD.DOC, INSTALL.BAT, INSTALL.TXT and CAMD.BAT. The CAMDREAD.DOC contains the instructions for installing the CAMD system. The INSTALL.BAT is the batch file that installs the CAMD system from the three floppy disks to the hard drive. The INSTALL.TXT contains the messages that are displayed during installation. The CAMD.BAT is the batch file that starts the CAMD system once it has been installed.

**CAMDREAD.DOC.**

Computer-Assisted Medical Diagnosis Installation.

The CAMD system needs 20 Mega bytes on a hard drive. This package includes a 3.5" high density (1.44M) floppy disks.

To install the CAMD system, complete the following:

1. Put CAMD INSTALLATION DISK into disk drive (A or B)

2. Goto floppy disk drive. Type A: or B:

3. Type> INSTALL -option d:

   option:    -a  extract all
            -d  only extract database.
            -u  only extract utility files.
            -x  only extract executable file.

   drives:    d:  destination drive (c: or d:)

   **EXAMPLE:**  INSTALL -a c:

4. In the root directory (C:\) modify or add the FILES and SHELL commands in the CONFIG.SYS file. The FILES command should be set to 50 or more (FILES=50). The SHELL command should read:

   SHELL=COMMAND.COM /P /E:512) for DOS 3.2 +
   or   SHELL=COMMAND.COM /P /E:32) for DOS 3.1 and below.

5. Reboot the system.

6. At the DOS prompt type C:\CAMD>CAMD.

7. The password is CAMD.
| INSTALL.BAT | echo off  
| CAMD Installation batch file. | :install.bat hll@nhrc  
| | if "%2"="" goto L1  
| | cls  
| | type install.txt  
| | pause  
| | cls  
| | if exist %2\camd goto camd  
| | md %2\camd  
| | :camd  
| | cd %2\camd  
| | if "%1"=="-a" goto all  
| | if "%1"=="-d" goto data  
| | if "%1"=="-u" goto util  
| | if "%1"=="-x" goto exe  
| | goto L1  
| | :all  
| | camd.exe -d %1\camd  
| | goto done  
| | :data  
| | camd.exe -d data\*. * %2\camd  
| | goto done  
| | :util  
| | camd.exe -d util\*. * %2\camd  
| | goto done  
| | :exe  
| | camd.exe -d bin\*. * %2\camd  
| | :done  
| | cls  
| | echo Remove Disk from Drive  
| | echo CAMD installation completed!!!  
| | goto end  
| | :L1  
| | echo format: INSTALL -option d:  
| | echo option: -a extract all  
| | echo -d only extract database.  
| | echo -u only extract utility files.  
| | echo -x only extract executable file.  
| | echo d: destination drive (c: or d:;)  
| | echo EXAMPLE: INSTALL -a b: c:  
| | :END |
**Report Documentation Page**

Public reporting burden for this collection of information is estimated to average 1 hour per response, including the time for reviewing instructions, searching existing data sources, gathering and maintaining the data needed, and completing and reviewing the collection of information. Send comments regarding this burden estimate or any other aspect of this collection of information, including suggestions for reducing this burden, to Washington Headquarters Services, Directorate for Information Operations and Reports, 1215 Jefferson Davis Highway, Suite 1204, Arlington, VA 22202-4302, and to the Office of Management and Budget, Paperwork Reduction Project (0704-0188), Washington, DC 20503.

<table>
<thead>
<tr>
<th>1. AGENCY USE ONLY (Leave blank)</th>
<th>2. REPORT DATE</th>
<th>3. REPORT TYPE AND DATE COVERED</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>SEPTEMBER 95</td>
<td>FINAL</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>4. TITLE AND SUBTITLE</th>
<th>USER'S GUIDE FOR THE NAVY COMPUTER-ASSISTED MEDICAL DIAGNOSIS (NCAMD) SYSTEM VERSION 2.0</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>5. FUNDING NUMBERS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program Element: 63706N</td>
</tr>
<tr>
<td>Work Unit Number: M0095.005-6103</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>6. AUTHOR(S)</th>
</tr>
</thead>
<tbody>
<tr>
<td>LY, H.L., MERRILL, L.L. &amp; PEARSSALL, D.M.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>7. PERFORMING ORGANIZATION NAME(S) AND ADDRESS(ES)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Naval Health Research Center</td>
</tr>
<tr>
<td>P. O. Box 85122</td>
</tr>
<tr>
<td>San Diego, CA 92186-5122</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>8. PERFORMING ORGANIZATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report No. 93-22</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>9. SPONSORING/MONITORING AGENCY NAME(S) AND ADDRESS(ES)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Naval Medical Research and Development Command</td>
</tr>
<tr>
<td>National Naval Medical Center</td>
</tr>
<tr>
<td>Building 1, Tower 2</td>
</tr>
<tr>
<td>Bethesda, MD 20889-5044</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>10. SPONSORING/MONITORING AGENCY REPORT NUMBER</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>11. SUPPLEMENTARY NOTES</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>12a. DISTRIBUTION/AVAILABILITY STATEMENT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approved for public release; distribution is unlimited.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>12b. DISTRIBUTION CODE</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>13. ABSTRACT (Maximum 200 words)</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Navy Computer-Assisted Medical Diagnosis (NCAMD) system is designed to assist Independent Duty Corpsmen (IDCs) in rendering a medical diagnosis. The NCAMD system was written using Microsoft FoxPro, Version 2.0, database management system. For each encounter the signs, symptoms, and laboratory information collected can be gathered on data entry forms created for NCAMD or entered directly (real time) into the system. A Chronological Record of Medical Care (SF600) can be generated automatically to document the encounter.</td>
</tr>
</tbody>
</table>

The NCAMD system User's Guide was written to familiarize the IDCs with the NCAMD software. The keyboard and mouse commands necessary to run the various options are explained in conjunction with the associated screens.

<table>
<thead>
<tr>
<th>14. SUBJECT TERMS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rule Based Algorithms</td>
</tr>
<tr>
<td>Management Information Systems</td>
</tr>
<tr>
<td>Computer-Assisted Diagnosis</td>
</tr>
<tr>
<td>Medical Management Support</td>
</tr>
<tr>
<td>Expert Systems</td>
</tr>
<tr>
<td>Decision Systems</td>
</tr>
<tr>
<td>Information Systems</td>
</tr>
<tr>
<td>Surveillance Systems</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>15. NUMBER OF PAGES</th>
</tr>
</thead>
<tbody>
<tr>
<td>42</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>16. PRICE CODE</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>17. SECURITY CLASSIFICATION OF REPORT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unclassified</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>18. SECURITY CLASSIFICATION OF THIS PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unclassified</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>19. SECURITY CLASSIFICATION OF ABSTRACT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unclassified</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>20. LIMITATION OF ABSTRACT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unlimited</td>
</tr>
</tbody>
</table>

NSN 7540-01-280-5500